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A	vocal	remover	is	simply	a	tool	for	extracting	and	separating	vocals	from	video	or	audio.	You	may	want	to	remove	vocals	for	karaoke	singing	or	practice,	podcast	listening,	ringtones,	and	add	your	own	instrumentals	to	the	lyrics.	But	finding	a	tool	for	separating	vocals	from	instrumentals	can	be	challenging.	You	need	to	consider	features	like	audio
clarity,	free	of	use,	audio	editing,	etc.	So,	if	you	want	to	find	the	best	song	vocal	remover,	keep	reading	this	post.	Part	1.	Top	10	Vocal	Remover	for	Windows,	Mac,	Android,	and	iPhone	1.	Vocal	Remover	of	Wondershare	UniConverter[100%	Free	for	a	limited	time]	Compatibility:	macOS	and	Windows	Wondershare	UniConverter	is	a	professional	vocal
remover	and	isolation	software	for	desktops.	It's	simple	and	extracts	vocals	from	various	audio	and	video	formats.	You	can	remove	song	lyrics	from	MP4,	MOV,	VOB,	FLV,	MTS,	3GP,	MP3,	MP2,	AAC,	etc.	Just	upload	your	file,	and	the	AI	system	will	analyze	and	extract	vocals	from	your	file.	Then,	after	removing	vocals,	you	can	use	the	audio	editor	to
trim,	cut,	split,	and	convert	to	any	audio	format	of	your	choice.	Best	voice	remover	to	remove	vocals	from	any	song	automatically	with	AI	algorithm.	Best	Vocal	Remover	for	Music	Lovers,	Musical	Instrument	Fans,	and	Music	Producers.	Isolates	voice	and	instruments	in	any	song.	Support	uploading	MP3,	M4A,	WAV,	OGG,	MP4,	MOV,	MKV,	AVI	files	to
remove	vocals.	Useful	for	creating	backing	tracks	or	karaoke.	Save	any	online	video	from	more	than	10,000	platforms	and	sites.	Below	is	how	to	extract	vocals	using	Wondershare	UniConverter:	Step	1	Upload	your	video/audio	file.	Install	and	run	Wondershare	Vocal	Remover	on	your	computer,	and	tap	Tools.	Then,	click	the	Vocal	Remover.	Clicking
the	Add	Files	button	to	browse	and	upload	your	video	or	audio	file.	Alternatively,	simply	drag	and	drop	the	media	file.	Step	2	Separate	vocals	from	instrumentals.	After	uploading	your	file	successfully,	UniConverter	will	automatically	analyze	and	extract	audio	vocals	from	your	uploaded	audio	or	video.	The	sound	will	be	extracted	in	MP3	format.	Step	3
Export	and	save	karaoke	or	vocals	Last	but	not	least,	tap	the	Play	button	on	the	Vocal	track	to	preview	it.	If	satisfied,	click	Export	to	save	the	vocal	file	to	your	local	storage.	Remember,	you	can	export	both	the	vocal	and	instrumental	files.	Remove	vocals	from	any	song	with	the	AI-powered	feature.	2.	Adobe	Audition	[Paid	software]	Compatibility:
macOS	and	Windows	Adobe	Audition	is	a	powerful	audio	creation	software	for	Mac	and	Windows.	Although	it's	not	beginner-friendly,	this	software	will	give	you	a	stellar	audio	post-production	experience.	With	Adobe	Audition,	you'll	enjoy	a	Multitrack	and	Waveform	view	for	stereo	editing,	mixing	tracks,	recording	audio,	and	adjusting	volume.	Another
exciting	feature	about	Audition	is	the	10,000+	royalty-free	sound	effects	and	loops	to	give	you	a	headstart	in	audio	post-production.	However,	the	$19.99/month	subscription	may	be	high.	3.	Audacity	[Free	and	open	source]	Compatibility:	macOS,	Windows,	and	Linux	If	you're	looking	to	create	and	edit	audio	for	free,	consider	Audacity.	It's	a	powerful
cross-platform	desktop	program	that	is	free	and	open-source.	With	Audacity,	you	can	easily	import,	mix,	merge,	record,	extract,	and	perform	other	audio	editing	tasks.	To	isolate	vocals,	the	technique	split	the	stereo	track	and	transformed	them	into	Mono.	Then,	you'll	choose	to	Invert	under	the	Effect	tab.	It	can	be	challenging	for	beginners,	but	it's
certainly	worth	it.	It	can	be	exceedingly	confusing.	It	doesn't	extract	vocals	from	videos.	4.	Vocal	Remover	and	Isolation	of	vocalremover.org	[Free	but	limited	audio	size]	Compatibility:	Online	Vocal	Remover	and	Isolation	is	a	free	AI	program	for	extracting	vocals	and	instrumentals	online	on	desktops	and	mobile	phones.	With	it,	you	can	browse	your
local	storage	and	upload	video	or	audio	before	removing	vocal	files.	Also,	you	can	directly	record	high-quality	audio	using	the	inbuilt	voice	recorder.	And	best	of	all,	you	can	trim	and	merge	audio	before	exporting.	You	should	give	it	a	try!	5.	LALAL.AI	[Free	but	up	to	20	files]	Compatibility:	Online	LALAL.AI	is	a	browser-based	music	vocal	remover	with
fast	and	quality	extractions.	It	lets	users	extract	vocals,	beats,	piano,	drums,	and	other	instrument	sounds	from	music.	Excitingly,	you	can	extract	up	to	10	minutes	of	vocals	for	free.	Also,	the	supported	input	and	output	formats	include	MP3,	WAV,	and	OGG,	although	you	can	get	more	options	with	the	pro	plans.	The	pro	plans	will	also	give	you
additional	extraction	minutes	and	audio	size.	1.	Vocal	Remover	AI	Average	Ratings	4.5/5	Compatibility	iPhone	(iOS	11	or	newer)	Free	√	No	Watermark	√	Ad-free	√	Vocal	Remover	AI	is	an	iPhone	app	that	uses	advanced	AI	capabilities	to	extract	and	separate	vocals	from	audio.	After	uploading	audio	and	removing	vocals,	you	can	preview	the	new	audio
and	save	it	as	MP3	or	export	it	to	other	applications.	You	can	also	record	high-quality	audio.	2.	Vocal	Remover	for	Karaoke	Average	Ratings	5/5	Compatibility	iPhone	(iOS	9.3	or	newer)	and	Android	Free	√	No	Watermark	√	Ad-free	X	Use	Vocal	Remover	for	Karaoke	to	transform	your	local	music	files	to	karaoke	on	Android	and	iPhone.	It	scans	through
your	entire	local	audio	library	and	chooses	an	audio	file	to	transform.	To	create	vocals,	just	enable	the	"Remove	Vocal"	slider,	and	that's	it.	All	that	for	free!	3.	Vocal	Extractor-	Karaoke	maker	Average	Ratings	4.2/5	Compatibility	iPhone	(iOS	13.1	or	newer)	Free	√	No	Watermark	√	Ad-free	X	Vocal	Extractor	is	an	easy	vocal	extraction	software	for
iPhones	and	iPads.	With	it,	you	can	instantly	make	karaoke	and	acapella	songs	from	your	Music	Library.	You	can	import	WAV,	MP3,	or	M4A	files,	including	DRM-protected	files.	4.	SplitHit	Average	Ratings	3.7/5	Compatibility	iPhone	(iOS	13.0	or	newer)	and	Android	Free	√	No	Watermark	√	Ad-free	X	SplitHit	is	a	vocal	remover	for	Android	and	iPhones.
Besides	extracting	vocals,	it	also	supports	backing	tracks,	removing	instruments,	and	recording	audio.	Excitingly,	SplitHit	supports	stem	extraction	for	top-quality	bass,	piano,	vocals,	drum,	etc.	Plus,	it	offers	an	equalizer	music	listening	experience.	5.	AI	Vocal	Remover	for	karaoke	Average	Ratings	3.8/5	Compatibility	iPhone	(iOS	8.0	or	newer)	Free	√
No	Watermark	√	Ad-free	X	Lastly,	use	this	AI-powered	software	to	quickly	and	losslessly	extract	vocals	from	songs	on	your	iPhone	or	iPad.	It's	a	free	app	that	uses	a	Que-based	system	to	separate	vocals,	drums,	pianos,	guitars,	etc.	You	can	also	remove	vocals	from	videos.	Part	2.	Frequently	asked	questions	about	Vocal	Remover	Choosing	the	best
vocal	remover	can	be	somewhat	challenging.	You	need	to	find	one	that	offers	compatibility	with	audio	and	video	formats.	Also,	post-production	editing	support	is	an	added	advantage.	And,	of	course,	the	vocal	quality	should	be	crisp-clear.	It's	highly	recommended	to	use	the	vocal	remover	of	UniConverter.	You	will	find	it	a	wonderful	tool.	A	vocal
remover	is	software	for	scanning	and	extracting	vocals	from	audio	or	video.	It	uses	AI	to	automatically	separate	vocals	from	instrumentals	such	as	bass,	drum,	piano,	guitar,	etc.	Separating	vocals	from	instrumentals	is	relatively	straightforward,	whether	on	mobile	or	PC.	The	thing	is	that	most	of	these	programs	use	AI	and	ML	to	scan	and	extract
songs.	So,	just	upload	your	audio,	and	the	vocal	remover	will	do	all	the	heavy	lifting.	Yes,	you	can	use	Audacity	to	remove	vocals	from	audio.	To	do	that:	Select	the	audio	and	then	click	Edit	>	Copy	to	copy	the	track.	Create	a	new	stereo	track	by	clicking	Tracks	>	Add	New	>	Stereo	Track.	Make	a	copy	of	the	original	track	in	the	stereo	file	by	clicking
Edit>	Paste.	Select	the	copied	track	and	extract	vocals	by	clicking	Effect	>	Vocal	Reduction	and	Isolation.	Lastly,	click	Effect	>	Noise	Reduction	>	Ok.	That's	it!	Part	3.	Conclusion	Some	song	vocal	remover	apps	like	LALAL.AI	and	Audacity	even	support	stem	extraction	for	drums,	piano,	guitar,	and	other	instrumentals.	But	for	a	simple	vocal	extraction
process	on	desktops,	use	Wondershare	UniConverter.	And	remember	to	use	the	program's	audio	editing	capabilities	to	retouch	your	vocals	before	sharing.	Have	fun!	Are	you	a	fun-loving	party	reveler	who	greatly	enjoys	karaoke	nights?	Sometimes,	you	need	the	help	of	a	karaoke	converter	tool	to	enjoy	your	favorite	tracks	on	a	DJ	night.	Other	times,
you	might	want	to	enjoy	your	everyday	activities	while	listening	to	the	instrumentals	from	your	favorite	song.	In	the	proceeding	read,	you	can	learn	some	remarkable	MP3	to	karaoke	converters	online	free	to	sing	along	to	your	favorite	songs.	If	you	wish	to	vibe	to	a	song	available	only	on	YouTube,	you	can	do	so	with	the	top	YouTube	to	karaoke
converter	online	free	mentioned	below.	If	you	are	looking	for	an	MP3	to	karaoke	converter	online	free,	you	have	landed	at	the	right	place.	Below,	you	can	find	the	four	best	online	converter	tools	to	help	you	convert	your	favorite	song	to	karaoke.	1.	MP3	to	Karaoke	Tool	MP3	to	Karaoke	✔	Maximum	Audio	Size	Not	Specified	Maximum	Audio	Duration
Not	Specified	Free	✔	No	Ads	✖	The	MP3	to	karaoke	conversion	tool	is	an	efficient	online	karaoke	converter	for	free.	You	can	use	this	tool	to	extract	vocals	or	other	instruments	such	as	piano,	drum,	and	bass	from	a	song.	This	conversion	tool	uses	AI	technology	to	produce	incredible	karaoke	soundtracks	in	no	time.	Besides	MP3,	the	tool	also	supports
the	conversion	of	FLAC	and	WAV	files	to	karaoke.	You	can	convert	a	song	into	karaoke	using	this	conversion	tool	by	following	the	steps	mentioned	below:	Step	1:	Start	by	launching	the	tool	on	a	supported	web	browser.	Then,	upload	your	source	MP3	file	to	the	sit.	You	can	upload	files	from	the	local	device	storage,	URL,	or	access	them	through	a	cloud
storage	service	such	as	Dropbox	and	OneDrive.	Step	2:	After	you	have	uploaded	your	file,	click	on	the	"Start	Conversion"	button.	Depending	on	the	size	of	your	audio	file,	the	conversion	process	can	take	some	time.	Step	3:	After	the	conversion	process	has	commenced,	you	can	download	the	file	by	scanning	the	QR	code	or	clicking	on	"Save."	2.
Karaoke	Maker	Vocal	Remover	MP3	to	Karaoke	✔	Maximum	Audio	Size	Not	Specified	Supported	Audio	Formats	MP3,	OGG,	WAV	Free	✔	No	Ads	✖	Karaoke	Maker	by	Humtools.com	is	another	song	to	karaoke	converter	online	free	which	can	prove	valuable	to	you.	The	tool	can	remove	vocals	from	MP3,	OGG,	and	WAV	file	formats,	leaving	you	with
crisp	audios	which	can	be	used	for	karaoke	purposes.	Here	is	how	you	can	convert	a	song	to	karaoke	online	using	Karaoke	Maker	Vocal	Remover	tool:	Step	1:	Tap	on	the	dotted	boundary	to	add	your	audio	file	from	your	local	storage.	The	tool	will	then	start	converting	your	MP3	file	to	karaoke.	Step	2:	Once	your	file	is	ready,	you	can	save	it	to	your
device	by	clicking	on	the	"Download"	button	visible	on	the	site.	3.	Vocals	Remover	MP3	to	Karaoke	✔	Maximum	Audio	Size	80MB	Maximum	Audio	Duration	10	Minutes	Free	✔	No	Ads	✖	Vocals	Remover	is	another	splendid	karaoke	maker	tool	that	can	effortlessly	convert	your	audio	into	karaoke.	The	tool	features	a	simple	interface	and	can	support
MP3	and	WAV	files.	The	site	offers	free	conversion	of	up	to	2	songs	per	day	and	maximum	file	size	of	80	MBs.	To	create	a	karaoke	song	from	MP3	on	Vocals	Remover,	you	can	follow	these	steps:	Step	1:	Click	on	the	"Upload"	button	to	add	a	locally	stored	file	on	the	site.	You	can	also	drag	and	drop	MP3	files	to	the	tool	easily.	The	maximum	length
supported	by	Vocals	Remover	is	10	minutes.	Step	2:	It	can	take	some	to	remove	vocals	from	your	file.	Once	the	process	is	complete,	you	can	download	the	instrumental	karaoke	audio	without	the	vocals	by	clicking	on	the	"Download	the	instrumental"	button.	Your	converted	audio	will	be	available	at	the	site's	server	24	hours	after	conversion.	4.
PhonicMind	MP3	to	Karaoke	✔	Maximum	Audio	Size	100MB	Maximum	Audio	Duration	Not	Specified	Free	✔	No	Ads	✔	PhonicMind	is	an	intuitive	tool	with	an	attractive	interface	that	can	act	as	a	free	vocal	remover	tool.	Besides	vocals,	you	can	also	easily	separate	drums,	bass,	or	other	instruments	from	audio.	With	state-of-the-art	AI	and	powerful	HiFi
qualities,	PhonicMind	can	help	you	create	the	perfect	soundtracks	for	karaoke	nights.	Follow	the	steps	mentioned	below	to	use	PhonicMind	as	an	MP3	to	karaoke	converter	online	free:	Step	1:	On	the	main	interface	of	the	tool,	click	on	"Let's	go"	to	upload	your	MP3	file.	You	can	choose	or	drag	files	with	a	maximum	file	size	of	100	MBs	on	PhonicMind.
Step	2:	The	tool	will	automatically	remove	vocals,	drums,	bass,	and	other	instruments	from	your	audio	into	separate	files.	Step	3:	You	can	choose	the	"Karaoke"	option	from	the	dropdown	menu	and	hit	"Download"	to	save	your	converted	audio	file	to	your	device.	Part	2.	3	best	YouTube	to	karaoke	converters	online	free	Various	online	tools	can	prove
useful	if	you	want	to	remove	vocals	from	a	YouTube	video	and	convert	it	into	a	karaoke	song.	Here	is	a	list	of	some	of	the	best	converter	tools	that	can	easily	act	as	YouTube	to	karaoke	converters.	1.	Vocal	Remover	Pro	YouTube	to	Karaoke	✔	Free	✔	No	Ads	✔	Vocal	Remover	Pro	is	an	online	karaoke	converter	free	of	cost	that	can	come	in	handy	when
you	want	to	convert	a	YouTube	video	into	karaoke.	It	can	help	you	generate	quality	tracks	without	the	vocals,	which	you	can	stream	on	karaoke	nights.	Be	it	for	personal	use,	family	nights,	or	studio	purposes,	the	tool	can	be	used	for	all.	Vocals	Remover	Pro	uses	a	simple	yet	smart	algorithm	that	makes	it	an	efficient	YouTube	to	karaoke	converter
online	free.	You	have	to	paste	the	video	URL,	and	it	will	do	the	rest	of	the	job	quite	effectively.	The	tool	supports	unlimited	conversions	and	is	easily	accessible	through	almost	all	web	browsers.	2.	Musicara.ml	YouTube	to	Karaoke	✔	Free	✔	No	Ads	✔	A	unique	online	tool	that	can	prove	beneficial	in	converting	YouTube	videos	to	karaoke	songs	is
Musicara.ml.	With	an	intuitive	interface	and	dedicated	set	of	features,	you	can	remove	vocals	from	a	YouTube	video,	leaving	behind	a	high-quality	audio	file	for	your	karaoke	nights.	The	conversion	process	on	Musicara.ml	is	quite	simple.	All	you	need	to	do	is	paste	your	video	URL,	and	it	will	split	the	file	into	multiple	parts	as	specified.	Ranging	from	2
to	5	stems,	you	can	split	your	video	into	vocals,	music,	bass,	drums,	and	piano.	Musicara.ml	can	also	send	you	the	links	of	converted	files	directly	to	your	mailbox.	3.	Karaoke	Maker	YouTube	to	Karaoke	✔	Free	✔	No	Ads	✖	If	you	are	looking	for	a	straightforward	MP4	to	karaoke	converter	online	free,	you	can	try	Karaoke	Maker.	It	is	a	purpose-built
tool	that	can	effortlessly	create	karaoke	versions	of	a	YouTube	video	of	your	choice.	Once	you	add	the	URL	to	your	chosen	YouTube	video,	Karaoke	Maker	will	remove	the	vocals	automatically	and	also	add	textual	lyrics	so	you	can	sing	along	to	the	song.	The	tool	delivers	premium	quality	audio	files	at	an	impressively	fast	pace.	Part	3.	Best	MP3/MP4	to
karaoke	converter	for	Windows	and	Mac	recommended	Many	online	karaoke	converter	tools	support	transform	audio	and	video	files	into	karaoke	songs.	But	if	you	are	looking	for	the	best	online	karaoke	converter	for	free,	the	answer	lies	in	Wondershare	UniConverter.	Primarily	a	video	converter	and	editor	tool,	UniConverter	offers	a	Vocal	Remover
feature	using	which	you	can	separate	the	vocals	and	instrumentals	from	audio	and	video	files.	With	an	effective	AI	algorithm,	UniConverter	can	provide	you	with	first-rate	karaoke	audio	tracks	for	multiple	purposes.	This	feature	is	free	for	all	the	users	of	UniConverter	for	a	limited	time	only.	Best	voice	remover	to	remove	vocals	from	any	song
automatically	with	AI	algorithm.	Best	Vocal	Remover	for	Music	Lovers,	Musical	Instrument	Fans	and	Music	Producers.	Isolates	voice	and	instruments	in	any	song.	Support	uploading	MP3,	M4A,	WAV,	OGG,	MP4,	MOV,	MKV,	and	AVI	files	to	remove	vocals.	Useful	for	creating	backing	tracks	or	karaoke.	Save	any	online	video	from	more	than	10,000
platforms	and	sites.	Here	is	a	step-by-step	guide	on	how	to	use	the	Vocal	Remover	feature	of	UniConverter	to	isolate	vocals	and	instrumentals	from	an	audio	or	video	file:	Step	1	Open	the	Vocal	Remover	tool.	Download	and	launch	Wondershare	UniConverter	on	your	Windows	or	Mac	PC.	In	the	main	interface	of	the	program,	look	for	the	Home	tab	in
the	left	panel.	Find	the	AI	Lab	section	from	here	and	select	the	Vocal	Remover	feature.	Step	2	Insert	the	source	file.	Now	insert	your	source	file	either	in	MP3	audio	or	an	MP4	video	file.	You	can	also	drag	and	drop	the	source	file	into	the	program.	Step	3	Save	the	karaoke	file.	Vocal	Remover	will	start	analyzing	and	processing	your	files	as	soon	as	the
files	are	inserted.	You	will	get	the	converted	files	with	vocals	and	instruments	removed	separately	in	seconds.	You	can	Export	the	file	you	want	or	save	all	of	them	collectively	to	a	location	of	your	choice.	Remove	vocals	from	any	song	with	the	AI-powered	feature.	Part	4.	FAQs	about	song	to	karaoke	converter	online	free	To	convert	a	song	to	karaoke,
you	can	take	the	assistance	of	a	capable	karaoke	converter.	Many	such	tools	are	available	in	the	market,	both	online	and	offline	software.	One	such	remarkable	tool	is	Wondershare	UniConverter,	which	can	yield	proficient	results	as	a	karaoke	converter	with	its	vocal	remover	feature.	Yes,	it	is	possible	to	remove	vocals	from	an	MP3	audio	file.	All	you
need	is	a	vocal	remover	tool,	which	Wondershare	UniConverter	offers	for	free.	Using	this	feature,	you	can	remove	vocals	from	an	audio	file	easily.	Using	Karaoke	Maker	by	Humtools.com	Step	1:	Tap	on	the	dotted	boundary	to	add	your	audio	file	from	your	local	storage.	The	tool	will	then	start	converting	your	MP3	file	to	karaoke.	Step	2:	Once	your	file
is	ready,	you	can	save	it	to	your	device	by	clicking	on	the	"Download"	button	visible	on	the	site.	You	can	use	Moises	App	(Available	on	Android	and	iPhone),	SonicMelody	(Available	on	Android),	or	Vocal	Extractor	-Karaoke	maker	(Available	on	iPhone)	to	remove	vocals	from	a	song	easily.	Conclusion	There	are	several	karaoke	converters	available
online	that	can	help	you	convert	MP3	audio	files	or	YouTube	videos	to	karaoke	for	free.	With	the	aforementioned	guide	now	at	your	hand,	you	can	choose	which	tool	best	suits	your	needs.	To	achieve	the	best	results,	you	can	try	the	vocal	remover	feature	of	Wondershare	UniConverter.
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